Riproduci simultaneamente un evento della stazione di
condivisione multimediale e un evento di registrazione
video/foto sullo stesso computer eseguendo 2 istanze di
RightBooth con 2 monitor su un desktop Windows esteso

Questo tutorial fornisce una guida dettagliata su come eseguire contemporaneamente 2 istanze (copie) di
RightBooth sullo stesso computer, con una registrazione di video e foto e I'altra che fornisce una funzione
Sharing Station per consentire agli utenti di scaricare foto e video sui propri telefoni cellulari, il tutto senza
richiedere alcuna connessione a Internet.

E (ancora meglio), ti costera solo il prezzo di un router WiFi economico , che probabilmente non ti costera
nulla se, come me, hai un vecchio router che raccoglie polvere in un armadio da qualche parte.

Requisiti

e Computer Windows.

e 2 monitor (idealmente monitor touchscreen ).

e Unrouter.

e Cavo Ethernet (opzionale).

e RightBooth . Versione 7.7.15 o successiva.

e 2 codici prodotto RightBooth , uno per ogni istanza in esecuzione di RightBooth

Elenco delle attivita

e Attivita 1 — Configurazione di un server Web locale — Un'attivita una tantum.

e Attivita 2 — Configurare una rete locale privata — Un'attivita una tantum.

e  Attivita 3 : creare un evento stazione di condivisione RightBooth .

e Attivita 4 : creare un evento di registrazione RightBooth per inviare video e foto al server Web
locale.

e  Attivita 5 : configurare un desktop esteso di Windows.

e  Attivita 6 : eseguire 2 istanze di RightBooth per riprodurre entrambi gli eventi contemporaneamente

Ora segui attentamente tutti i passaggi di questo tutorial e avrai un evento di registrazione video/foto
perfettamente funzionante e un evento Sharing Station in esecuzione simultaneamente su un computer.



Attivita 1: configurare un server Web locale

Informazioni sullo sfondo

| server Web sono app che di solito vengono eseguite su computer remoti dedicati (da qualche parte su
Internet) e ospitano la maggior parte dei siti Web del mondo. Quando inserisci I'indirizzo di un sito web nel
tuo browser, il browser viene indirizzato al server web appropriato (da qualche parte nel mondo) e quel
server restituisce quindi le pagine web pertinenti al tuo browser.

La stazione di condivisione RightBooth che stai creando utilizzera un server Web locale e sara responsabile di
fornire le foto e i video RightBooth ai tuoi utenti, ma non vogliamo che il server Web venga eseguito su un
computer remoto e non Non vogliamo coinvolgere Internet, quindi abbiamo bisogno che il server web venga
eseguito localmente sul tuo computer. RightBooth ha opzioni di integrazione disponibili per una delle due
applicazioni server web: WampServer e Xampp . Entrambe le app sono gratuite e puoi scegliere di utilizzare
quella che preferisci. Se vuoi usare WampServer, segui la sezione 1.1. Se scegli Xampp , segui la sezione 1.2.

1.1 - Wampserver

1.1.1 Scarica WampServer

Vai su https://wampserver.aviatechno.net/

Sii paziente, & un grosso file!

1.1.2 Installare i pacchetti richiesti da WampServer

Dopo aver scaricato il programma di installazione di WampServer , lo troverai nella cartella "Download" di
Windows, ma prima di iniziare l'installazione devi prima verificare di avere vari pacchetti Microsoft (richiesti
da WampServer ) installati sul tuo computer.

Per verificare se si dispone dei pacchetti necessari, visitare questo sito Web:

https://wampserver.aviatechno.net/

Scorri la pagina Web fino alla sezione: ' Pacchetti ridistribuibili di Visual C++ ':

| Visual C++ Redistribuable Packages |

| Microsoft VC4+ 4 Packages x86 (32 bits) | [ Microsoft VC Packages x64 (64bits)
VC 2008 {VC3) 15 requred for PP 5.3 and 5.4 ¥C 2008 (VCS] Is required for P2 S.3 and 5.4
¢ VC 2010 SP1 Package (x86) MD5 CRDF0IN7ARS J449AICIRCSFARECODEDD 4 VC 2010 5P1 Package (x64) vos
4 VC 2012 Update 4 (xB6) 1os s VC 2012 Up 4 (x64) MD3
» VC 2013 Package Up S (x86) nos s VC 2013 Up 5 (x64) mos
» VC 2015-2019 (VC16 x86) 14,29.30133 mos o VC 2015-2019 (VC16 x64) 14.29.30133 o>

VE2015-2019 (VC16) = backward compatile to VC2015 (WCI4) and YC2017 (VCIS) That means, a WCI4 or VW15 module can Be ssed insdle a WIS dnary. Because s
compatibilty the version number of the Redistributable is 14.2¢xx and after you install the Reditribitable VC2015-2019, the Redistrbutable packages VC2015 (VC14) and VC2017
(VC15) are eventually deleted but you can stil use VC14 and VCIS.

Qui troverai collegamenti a otto pacchetti Microsoft VC++ necessari per il corretto funzionamento di
WampServer .


https://wampserver.aviatechno.net/
https://wampserver.aviatechno.net/

Scarica ed esegui ciascuno dei quattro pacchetti x86 per installarli tutti.

Quindi, se stai utilizzando Windows a 64 bit (molto probabilmente), scarica ed esegui ciascuno dei quattro
pacchetti x64 per installarli tutti.

Nota che mentre installi i pacchetti probabilmente ti verra detto che uno o piu di essi sono gia installati sul
tuo computer, ma vale comunque la pena controllarli tutti. Potrebbe anche essere necessario riavviare il
computer alcune volte durante tutto questo. Ancora una volta, sii paziente, fai quello che ti chiede ciascuno
degli installatori.

Al termine, dovresti verificare di aver installato correttamente tutti i pacchetti.

Per fare cio, scorrere verso il basso fino alla sezione " Strumenti" del sito Web di cui sopra e fare clic sul

collegamento: " Controlla i pacchetti VC++ installati" :

y weampmanagerini repair oy
Rapaw tool for wampmanaegerni fie if #t is cocrupted o mussing. You can downlcad st ary bme, but instal thia tool saly #f you need i,
Decause £ takes into accomnt the cyrrest configurabion of Wampserver, A wampmaman e ni corrupted e i reflected mostly by arroey (ke
= Saligy launching Wampserver

| Tools

@ Checks VC+ + packages installed nos
e Alihe yC++ packsces nead Dserver 3 sce matafed conmectly
Do not use & provicysly loaded tool, Aways make & new doumicad to make sere you s geng the Comeet varson

Questo scarichera lI'app: ' check_vcredist.exe' nella cartella Download. Una volta scaricata, esegui questa
app e, quando ti viene chiesto, rispondi " No" a questa domanda:

Setup

Are you using a 5.3 or 5.4 version of PHP?
or will you use one?

tes

L'app verifichera quindi se tutti i pacchetti richiesti sono installati e, in tal caso, verra visualizzato questo

messaggio:

Setup >

AllVC++ packages needed to Wampserver are installed
correctly

Se non vedi questo messaggio, I'app ti dira quali dei pacchetti devono ancora essere installati.

1.1.3 Installare, eseguire e configurare WampServer



Una volta installati tutti i pacchetti menzionati in precedenza, puoi eseguire con sicurezza il programma di
installazione di WampServer che hai precedentemente scaricato nella cartella Download di Windows. Al
momento della scrittura, questo programma di installazione €: wampserver3.2.3_x64.exe

Durante |' installazione di WampServer ti verranno mostrate alcune schermate.

IMPORTANTE: accetta tutte le impostazioni predefinite e fai clic su " Avanti" in tutte le sezioni.
WampServer verra quindi installato nella cartella predefinita c:\wamp64 sul tuo computer.

Si prega di NON modificare la cartella di installazione di WampServer poiché sara necessaria se si sceglie di
utilizzare WampServer in RightBooth (vedere piu avanti).

Al termine dell'installazione, & necessario riavviare il computer.

Ora troverai |I' app WampServer ( Wampserver64 ) nel menu Start di Windows. Fare clic sull'icona per
eseguirlo. All'avvio di WampServer , vedrai apparire brevemente alcune finestre nere del prompt dei
comandi. Non preoccuparti, & normale.

Una volta che WampServer € in esecuzione, vedrai la sua icona sulla barra delle applicazioni di Windows.
L'icona puo apparire di colore rosso o arancione g, in tal caso, attendere fino a quando l'icona diventa verde,
il che significa che WampServer funziona correttamente. Se passi il mouse sopra l'icona vedrai il messaggio
mostrato in questa schermata:

. 21:32
13°C Mostly cloudy A~ £ Q) a 23/09/2021 %

Se I' icona di WampServer non diventa verde, mi dispiace ma non posso aiutarti, dovrai approfondire I'ampia
documentazione di WampServer per scoprire perché non funziona correttamente. Tutto quello che posso
dire e che ho installato WampServer su due dei miei computer e ha funzionato perfettamente su entrambi. E
conosco molti utenti di RightBooth che stanno facendo lo stesso senza problemi. Quindi sono
ragionevolmente fiducioso che avrai lo stesso risultato.

OK. Se sei arrivato cosi lontano, congratulazioni, ora stai eseguendo il tuo server Web locale sul tuo
computer. Per provarlo, avvia il browser e digita localhost nella casella di testo dell'URL del browser, premi il
tasto Invio e vedrai una pagina web simile a questa:
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Quello che stai guardando qui ¢ il sito Web locale predefinito che & stato installato da WampServer ed &
ospitato sul server Web locale sul tuo PC.

La posizione del server web locale WampServer e:
c:\wamp64\www

Usa Esplora file per navigare fino alla cartella sul tuo PC:

| = | www - O x
Home Share View - e
“ v » This PC » Windows (C:) > wampfd » www > v 0 L2 Search www
RightBooth Assets ™ Name Date modified Type Size
RightBoath? wamplangues 12/09/202113:19 File folder
2 Dropbox wampthemes 2 f2021 21:56 File folder
[ add_vhost.php 10/06/2020 12:09 PHP File 24KB
1 This PC [ favicon.ica 31/12/2010 08:40 Icon File 198 KB
¥ 30 Objects index.ph PHP File 21KB
php
[ Desktop [ 7] test_sockets.php PHP File 1KB
Documents [ testmysql.php PHP File TKE
; Downleads v
7 items f=2| =

Il tuo browser web ti sta attualmente mostrando la pagina web definita dal file index.php .




1.1.4 Rimuovere i file del sito Web WampServer predefinito

Il sito Web locale predefinito non e di alcuna utilita per noi, quindi lo elimineremo. Perché? Bene, se non lo
eliminiamo, potrebbe essere visualizzabile dagli utenti della tua stazione di condivisione quando utilizzano i
loro telefoni cellulari per accedere ai propri file. Questo non & davvero un problema, ma questo sito Web
non e richiesto, potrebbe creare confusione per i tuoi utenti se navigano su di esso e non ha alcuno scopo
per i tuoi utenti, quindi puoi tranquillamente eliminare tutto dalla cartella www.

Quindi, utilizzando Esplora file, rimuovi i file e le sottocartelle e ti verra lasciata questa cartella www vuota:

I [+ = | wwew — O x
Home Share View 9
= v « Windows (C:) » wampbd » www v O Search www
~ - e
I This PC Mame Date medified Type 5

§ 30 Objects
I Desktop

| Documents
; Downloads
D Music

This folder is empty,

= Pictures

E Videos
o Windows (C:)
== DATA (D) v £ >

Ditems  State: J& Shared =

Nota: per eseguire questa operazione, € necessario eseguire Windows con un account di accesso

amministratore.

Ora digita ancora una volta localhost nella casella di testo dell'URL del tuo browser, premi il tasto Invio e
vedrai una pagina web predefinita simile a questa, che indica che la cartella www di WampServer € ora
completamente vuota:

Index of /

Name Last modified Size Description

Apache’2.4.46 (WinG4) PHF/7.3.21 Server at localhost Port §0

IMPORTANTE: se non riesci ad accedere a questa pagina Web predefinita, potrebbe essere perché I'accesso
alla porta 80 & bloccato sul tuo computer. Questo video spiega come sbloccare la porta 80 sul tuo computer:

Come sbloccare tali porte: 80, 443, 25565, 4950, 2955, 20, 27015 su Windows 10e 7



https://youtu.be/OvvoFnkT-Xs

1. 1.5 Configura WampServer Consentire I'accesso esterno
L'ultima cosa che devi fare con WampServer &€ modificare uno dei suoi file di configurazione. Per fare questo:

e Fare clic sull'icona WampServer sulla barra delle applicazioni.
e Scegli " Apache" dal menu a comparsa .
o Scegli ' httpd-vhosts.conf ' dal sottomenu:

Made in France by Otomatic
@ Localhost
= : »
[& Version F= phpMyAdmin 502
v Service administration 'wampapache64' L4 g Adeiner 477
#) Apache modules b [ Your VirtualHosts ’
4| Apache settings L =] 2
o T
SR 5 »
[-_{L Alias directories tn / Apache 2.4.46
vy ;
[ — ™ el
= = Default DBMS: mysql
= R
(@ B nhitpd-vhosts.cont - 55 | (7 mysaL 5.731 >
e - Sl Nl £ MariaDe 10413 >
@ Apache access log _ (6.37 KiB) g: ) Help -> MariaDB - MySQL
[n_& Apache documentation : 3.2.3 - 64bit - Services
§ Start All Services
Stop All Services
Restart All Services

&
@

‘
@

B



Ora vedrai il file di configurazione aperto nel Blocco note. Modifica la riga che recita: ' Require local ' e
modificala in ' Require all secured ' in questo modo:

File Edit Format View Help
h Virtual Hosts
#
<VirtualHost *:80>
Serverfame localhost
Serverfilias localhost
DocumentRoot "${INSTALL_DIR}/wwn"
<Directory "${INSTALL DIR}/uwnm/™>
Options +Indexes +Includes +FollowSymlinks +MultiViews
AllowOverride All

Require all granted o ——

</Directory>»
</VirtualHost>»

Quindi fare clic su File -> Salva per salvare il file, sovrascrivendo I'originale. Questa modifica istruira
WampServer a consentire |'accesso al tuo sito Web da dispositivi diversi dal computer su cui € installato,
come telefoni cellulari o altri computer (vedi piu avanti).

Devi riavviare WampServer per applicare questa modifica alla configurazione. Per fare cio, fai clic con il
pulsante destro del mouse sull'icona della barra delle applicazioni di WampServer e scegli Esci dal menu a
comparsa, quindi riavvia WampServer dal menu Start.

Ora ricorda, I'unica cosa che devi fare ogni volta che riavvii il computer & assicurarti di eseguire WampServer
per far funzionare il tuo server web locale e pronto per I'azione!



1.2 - Xamp

Se preferisci usare Xampp (piuttosto che WampServer ) per il tuo server web locale, leggi questa sezione. Per
molti versi Xampp € pil facile da impostare e configurare e si pud vedere che fornisce una soluzione piu
reattiva.

1.2.1 Scarica Xampp

Scarica e installa 'ultima versione di Xampp per Windows qui:

https://www.apachefriends.org/download.html

Assicurati di installare Xampp nella cartella predefinita: c:\xampp
1.2.2 Pannello di controllo di Xampp

Imposta il pannello di controllo di Xampp in modo che venga eseguito con i diritti di amministratore per
impostazione predefinita.

e |n Esplora risorse, vai a:
e C:\ProgramData\Microsoft\Windows\Menu Start\Programmi\XAMPP

e Faiclic con il pulsante destro del mouse sul collegamento del pannello di controllo XAMPP e scegli
Proprieta dal menu a comparsa

e Nel pannello Proprieta scegli Avanzate

e Nel pannello Proprieta avanzate, seleziona " Esegui come amministratore" e fai clic sul pulsante OK
per salvare le modifiche:

N/
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https://www.apachefriends.org/download.html
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Ora esegui il pannello di controllo di Xampp :

e
ol Mo e B

KAV fap0cs “oye
) e Comsote Civvpwrent
- -

D v oswen

o ) T |

Nel pannello di controllo XAMPP, avvia il servizio Apache:

KAMPP Control Panel v330 [ Comprlert: Ape th 2021 | - o x
XAMPP Control Panel v3.3.0 =]
Nedaes Netatat

Sarvice  Module  Pilxs) Poriis) _Actions ¢
€ - o o i
x WysoL Start sty Conty Lags Expiorer
X FleZma Start try Conly Lsgs ¥ Servees
Wercary Stant Adeer Conlg Lega W Hepy
xX Tarcat Start atry Conlyg Legn 2 on
[man} Intalzing Control Panel
[man) Windows Versiva: Home &4.oxt
225 [man) KAMPP Version: 81.17
235 [manj Contrel Panel Version 330 [ Compled: Apr £2h 2021 |
25 [man} Running with Administrator nghts - good!
2.25 [man] XAMPF Instalistion Directory. "c 'wampp\”
5 [man] Checkng for grecagusies
5 [meen] All prerequasites Tound
5 [manj Intial@ing Modules
[man} Startng Check-Timar
[main) Contrel Fanel Ready

Puoi anche scegliere di avviare questo servizio automaticamente nella sezione Configurazione del pannello
di controllo di XAMPP :

1 [5) Configusation of Controt Pand = W} X
Editor:
| o tepad e
Srowser (enoty = system default)

{ isdstacanebuenes:

L_MysQe [C™ercury
Salected modulks wil be startad on next Bunch of the
Cantrol Panel

[J5tart Control Panel Mnesaed
(7] Eratle Toncat output wndow
) Crveck et ports on suwnp
[[]show debug nformation

La posizione del server web locale WampServer é:
c:\xampp\htdocs

Ora ricorda, l'unica cosa che devi fare ogni volta che riawvii il computer & assicurarti di eseguire Xampp per
far funzionare il tuo server web locale e pronto per I'azione!



Attivita 2: configurare una rete locale privata

Avere un server Web locale & un grande passo avanti verso I'esecuzione di una stazione di condivisione
RightBooth , ma non sara di alcuna utilita per i tuoi utenti a meno che non possano effettivamente accedere
al tuo server Web locale dai loro dispositivi mobili. Ecco come:

2.1 Procurati un router WiFi economico

Ora, se come me hai cambiato il tuo provider di servizi Internet (ISP) nel corso degli anni, potresti avere uno
o due vecchi router in un cassetto da qualche parte, quindi tirane fuori uno. Non deve essere un modello
sofisticato o fornire funzionalita all'avanguardia e non lo utilizzerai per connetterti a Internet. Se hai bisogno
di acquistare un router, guardati intorno. Posso garantire che sarai in grado di trovarne uno nuovo per meno
di £ 30.

In questo tutorial sto usando un router TP-Link N600 che ha circa 3 anni (al momento della scrittura):

Successivamente, controlla se il tuo computer ha una porta Ethernet RJ45 e, in tal caso, procurati un cavo
Ethernet RJ45 e collega il router al computer utilizzando una delle porte Ethernet sul retro del router:

IMPORTANTE: assicurarsi di collegare il cavo a una porta LAN del router (solitamente gialla), non collegare a
una porta WAN oa una porta Internet (blu). Controllare I'etichettatura della porta.

Ricorda che non utilizzerai Internet, quindi non & necessario collegare il router a nessun servizio a banda
larga, ad esempio una linea telefonica fissa, un cavo in fibra o un cavo satellitare.



Ora idealmente dovresti utilizzare un cavo Ethernet per la tua connessione router-computer, ma se il tuo
computer non ha una porta Ethernet, puoi comunque connetterti al tuo router tramite WiFi purché il tuo
computer abbia funzionalita WiFi . Se devi connettere il tuo computer al router tramite WiFi, apri il pannello
di connessione di rete nella barra delle applicazioni di Windows, individua il nome della rete WiFi (SSID) del
tuo router e connettiti ad esso. Avrai anche bisogno della password della rete WiFi del router , questa
dovrebbe essere mostrata su un'etichetta attaccata al router. Qui puoi vedere che la mia rete WiFi del router
TP-LINK ¢ disponibile per la connessione dal mio computer.
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Ma solo per ripetere, idealmente dovresti usare un cavo Ethernet per collegare il tuo computer al router
poiché questa & la connessione piu veloce e affidabile. Senza una porta RB45 sul tuo computer puoi
comungue ottenere una connessione cablata ottenendo un adattatore Ethernet USB, che costera circa S 10.
Cerca su Amazon "Adattatore Ethernet USB":

2.2 Controlla la configurazione del tuo router

Accendi il router e lascialo inizializzare. Ora devi controllare alcune cose sul router accedendo al suo pannello
di amministrazione.

Usa il tuo browser per accedere al router. Nel campo dell'indirizzo del browser, digita l'indirizzo IP del tuo
router. La maggior parte dei router utilizza per impostazione predefinita l'indirizzo IP: 192.168.1.1 , ma non &



sempre cosi, quindi potresti voler confermare l'indirizzo IP del tuo router. Per trovare l'indirizzo IP del tuo
router, digita cmd nella barra di ricerca di Windows e premi Invio per aprire una finestra del prompt dei
comandi. Nella finestra digitare ipconfige premi Invio. Scorrere le informazioni fino a visualizzare
un'impostazione per Gateway predefinito in Adattatore Ethernet (se connesso tramite cavo) o Adattatore
LAN wireless (se connesso tramite WiFi ). Il gateway predefinito e il router e il numero accanto ¢ l'indirizzo IP
del router. Quindi prendine nota. Qui puoi vedere che l'indirizzo IP del mio router TP-Link € 192.168.1.1:

Best match

- Command Prompt
App

Search the web

Command Prompt — O >4

/O cmd - See web results

Settings (1)

/O cmd

Quindi, nella barra degli indirizzi del tuo browser, digita l'indirizzo IP del tuo router e premi Invio per
accedere al pannello di login del tuo router. Qui puoi inserire il nome utente e la password
dell'amministratore del tuo router che dovresti trovare di nuovo su un'etichetta attaccata sul retro del
router. Nel mio esempio, il nome utente di accesso del mio router TP-Link &€ admin :

@

Tassnsnnnen




Dopo aver effettuato |'accesso al router, ci sono un paio di cose che devi controllare.

Nel pannello di amministrazione del router trova il server DHCP sezione Impostazioni e assicurati che sia
abilitata. In caso contrario, abilitalo. Prendere nota anche dell'indirizzo IP iniziale . Sul mio router TP Link
puoi vedere che il server DHCP ¢ abilitato e l'indirizzo IP iniziale € 192.168.1.100 (questo sara quasi
certamente un valore diverso sul tuo router):

DHCP Settings

Status
Quick Setup
Operation Mode
WTEET Group:  Default
DHCP Server IP Address:  192.168.1.1
DHCP Setfings Subnet Mask:  255.255.255.0
Clients List DHCP Server: () Disable @ Enable () DHCP Relay
L ]

Address Reservation

-1& 100

(3]
om

Start IP Address: |12
End IP Address: |122.1¢
Lease Time: minutes {1~2880 minutes. the default value is 1440)

Default Gateway: (optional)

DefaultDomain: [ |(optional)
LTS DNS Server: (optional)
USB Settings Secondary DNS Server: (optional}

Route Settings

1.
Conditional Pool
.1.159

=]

Dual Band Selection

Wireless 2.4GHz

o

Wireless 5GHz

Prendere nota di questo indirizzo IP iniziale poiché potrebbe essere necessario utilizzarlo in seguito.
E quindi possibile disconnettersi dall'app del pannello di amministrazione.

Informazioni sullo sfondo

“Allora di cosa si trattava? ” Beh, non voglio annoiarti con tutti i dettagli, ma fondamentalmente il tuo
router ti fornisce una rete WiFi locale privata . Solo i dispositivi che si trovano nel raggio del segnale WiFi
possono connettersi ad esso, ma solo se gli utenti conoscono il nome e la password della rete WiFi del router
. E ogni volta che un dispositivo (un computer, un tablet, un telefono, ecc.) si connette al router, il server
DHCP del router fornira al dispositivo un indirizzo IP temporaneo preso dall'intervallo di indirizzi IP iniziale-
finale. Quindi, con il mio router TP-LINK, al primo dispositivo che si connette viene assegnato l'indirizzo IP
192.168.1.100, al secondo dispositivo che si connette viene assegnato l'indirizzo IP 192.168.1.101 e cosi via.

Ora, poiché il tuo computer e il primo dispositivo a connettersi al router dopo che e stato acceso,
normalmente al tuo computer verra sempre assegnato l'indirizzo IP iniziale del router. Sul tuo computer,
puoi verificare che sia cosi eseguendo nuovamente un prompt dei comandi e digitando ipconfig . Questa
volta, cerca I' indirizzo IPv4 della riga e controlla I'indirizzo IP accanto ad essa. Questo & l'indirizzo IP del tuo
computer fornito dal router e nel mio esempio puoi vedere che il mio router ha fornito il suo indirizzo IP
iniziale (192.168.1.100) al mio computer:



. E¥ Command Prompt — O >

Windows IP Configuration

Ethernet adapter Ethernet:

Come ho detto, prendi nota di questo indirizzo poiché lo utilizzerai pit avanti in questo documento.

2.3 Testare la connessione al server Web locale utilizzando un altro dispositivo

Ora e il momento di verificare di poter accedere al server Web locale >

o®
del tuo computer da un altro dispositivo tramite una connessione /ﬁ
WiFi . LW £ 7 4l 655815
Quindi prendi un telefono cellulare e visita le sue Impostazioni di ON
connessione WiFi . }

Assicurati che la sua funzione WiFi sia attivata, quindi trova il nome TP-LINK_2.4GHz_DA7A14

del tuo router nell'elenco delle reti WiFi . —r
DIRECT-bt3D-TR4500series

Qui sul mio Samsung Galaxy S6 puoi vedere che il mio router TP-LINK SKY45584
e elencato tra alcune altre reti "nel raggio d'azione": +  Addnetwork




Successivamente, seleziona il tuo router sul tuo cellulare e connettiti
ad esso (dovrai inserire la password WiFi del router ).

Vedrai quindi che il tuo telefono & connesso al router, senza alcun
accesso a Internet, che e cio che vogliamo ottenere:

Ora puoi eseguire I'app del browser sul tuo telefono cellulare e digitare
I'indirizzo IPv4 del tuo computer nella barra degli indirizzi del browser.

Come puoi vedere nella schermata (a fianco) sto inserendo il mio
indirizzo IPv4 ( 192.168.1.100) .

Il tuo telefono accedera quindi al tuo computer e ti mostrera il sito Web
predefinito del server Web locale nel browser del tuo telefono.

Nello screenshot a fianco stiamo accedendo al sito web locale di
WampServer :

IMPORTANTE: se non riesci ad accedere alla pagina Web predefinita,
potrebbe essere perché I'accesso alla porta 80 & bloccato sul tuo
computer. Questo video spiega come sbloccare la porta 80 sul tuo
computer:

Come sbloccare tali porte: 80, 443, 25565, 4950, 2955, 20, 27015 su
Windows 10 e 7

f =

v

i, BT 4% @548

Wi-Fi WI-FI DIRECT  ADVANCED

ON

VM8334831

DIRECT-bt3D-TR4500series

SKY45584

TALKTALKDESEBA

+ Add network

N

ﬁ 0 0 Ceminesn . N
G
£ T4 HNE1554

N

X A 192.168.1.100 n <

192.168.1.100
|

Index of /

Apacke2.2.40 (Winds) PHP7.3 21 Sorver ar localiose Por: 80



https://youtu.be/OvvoFnkT-Xs
https://youtu.be/OvvoFnkT-Xs

IMPORTANTE : sein questa fase scopri che non riesci a connettere il tuo telefono al server web locale

del tuo computer, di solito significa che il tuo computer sta impedendo a WampServer (o Xampp ) di fornire i
dati del sito web attraverso la rete WiFi . In tal caso, prova quanto segue:

i) Interrompi I'esecuzione del tuo antivirus. Se stai eseguendo un antivirus sul computer,
potrebbe bloccare il processo, quindi chiudi I'app antivirus.

i) Arrestare Windows Firewall. Lo troverai in Sicurezza di Windows -> Firewall e protezione della
rete

iii) Disattiva I'app Windows Defender Firewall. Di nuovo lo troverai in Sicurezza di Windows ->
Firewall e protezione della rete

Esistono modi piu granulari per superare questa restrizione senza ricorrere all'arresto del controllo antivirus
o delle app firewall, ma se ci pensi, c'@ pochissimo pericolo che il tuo computer venga compromesso o
infettato da virus mentre non & connesso a Internet, quindi I'unica minaccia potrebbe provenire dagli utenti
che si trovano nel raggio del tuo router che conoscono anche la tua password WiFi . Pertanto suggerirei che
in questa situazione la minaccia per il tuo computer sia minima nella migliore delle ipotesi.

Congratulazioni! Ora stai utilizzando un server Web locale per servire un sito Web locale a dispositivi esterni
sulla tua rete Wi-Fi locale privata e sei un passo avanti verso la fornitura di una stazione di condivisione con
RightBooth .



2.4 Un esperimento illuminante

Quindi, solo per ricapitolare, ora hai un server web locale in esecuzione sullo stesso computer che eseguira
RightBooth Sharing Station e questo server & in grado di mostrare un sito web su qualsiasi dispositivo che si
connette ad esso tramite la tua rete WiFi locale privata . Ora hai un sistema pronto per servire contenuti
multimediali (video e foto) ai tuoi utenti.

Prima di continuare, voglio che tu provi un esperimento...

Sul computer, trova un file immagine e copialo nella cartella del server web locale. Qui puoi vedere che ho
inserito I'immagine pic.jpg nella cartella wamp64\www:

¥ v | images
“ Home Share View
— v A <« Windows (C:) > wamp6d > www v O

#* Quick access

Il Desktop *
- Downloads *
%] Documents *
& Pictures -
Google Drive »
- DATA (D2)
RightBooth & picjpg
1item

Nota: se stai eseguendo Xampp invece di WampServer , posiziona l'immagine nella cartella c:\xampp\htdocs

Ora torna al tuo telefono cellulare e nella barra degli indirizzi del browser web, inserisci il tuo indirizzo 1Pv4
seguito da /pic.jpg e cercalo. Nel mio esempio scrivo questo:

192.168.1.100/pic.jpg



E come per magia, ora stai visualizzando il pic.jpg sul tuo 0 @ G ]
telefono... '

X A Picipg (567x376) < i

152.168.1,100

E poi puoi scaricare la foto sul tuo telefono utilizzando la ‘ |
funzione di download del tuo telefono, che sul Galaxy S6 e

toccare e tenere premuta la foto per mostrare un menu a
comparsa, quindi scegliere Scarica immagine :

Open in new Chrome tab ‘
Open in Incognito tab ‘

Preview image

Copy Image

Cownload image )

Search Google for this image

Share image

ey

Nota: se questo non funziona per te, assicurati di eseguire WampServer (o Xampp ) sul tuo computer, poiché
qguesto mi ha colto diverse volte mentre scrivevo questo tutorial!

Quindi, come puoi vedere, se conosci il percorso completo e il nome file di una foto sul server Web locale del
computer, la foto puo essere visualizzata e scaricata utilizzando il browser Web del telefono e lo stesso vale
per i file video .

Quindi la regola generale qui € che qualsiasi sottocartella o file che si trova nella cartella del sito web locale
del computer ( WampServer : c:\wamp64\www o Xamp : c:\xampp\htdocs ) puo essere sfogliato su un
altro dispositivo connesso WiFi come purché il percorso sia reso noto all'utente del dispositivo.



Attivita 3: creare un evento stazione di condivisione RightBooth

Se non lo hai gia fatto, scarica e installa I'ultima versione di RightBooth sul computer. E disponibile da qui:

https://www.rightbooth.com/try.html

3.1 Aggiungere le impostazioni del server Web locale in RightBooth
Esegui RightBooth e vai su Impostazioni -> Social media -> Server web locale

Qui puoi scegliere I'app del server Web locale con cui desideri che RightBooth funzioni. Scegli WampServer o
Xampp .

Assicurati che la casella di testo Cartella server sia impostata su:
c:\wamp64\www \ ( per WampServer ) o
c:\xampp\htdocs\ (per Xampp )

Seleziona l'indirizzo IPv4 del tuo server . Se il tuo computer & connesso al router con un cavo Ethernet,
seleziona ' Ethernet' . Se & connesso tramite Wi-Fi, selezionare Wi-Fi . In questo modo, RightBooth utilizzera
automaticamente l'indirizzo IP richiesto fornito dal router. Vedrai che RightBooth ha rilevato
automaticamente il tuo indirizzo IPv4 fornito dal tuo router.

Se trovi che questo non funziona correttamente (vedi piu avanti) puoi selezionare ' Altro' e inserire
|'effettivo indirizzo IPv4 che viene fornito al computer dal router (vedi la sezione precedente relativa al
comando ipconfig ).

WiFi locale privata del tuo router . E necessario inserire il nome WiFi (SSID), la password e il metodo di
crittografia utilizzati dal router. RightBooth utilizzera queste informazioni in un secondo momento per
generare automaticamente un codice QR che consente ai tuoi ospiti di connettersi alla tua rete WiFi privata .

In questo screenshot di esempio puoi vedere che mi sto connettendo al mio router con un cavo Ethernet (su
192.168.1.100) e ho inserito i dettagli della mia rete WiFi TP-LINK:

(&) RightBooth Settings - ]

|Cameras Printers Userinput Overlays/Props  Text/Language Security Social media  Start/Stop Folders/Files Log Miscellaneous_

 Email server  Email notifications  Media size FTP Phone SMS  Local web server  WhatsApp

O WampServer @ Xampp WiFi network for OR code

cwampBdiwua’y (NPTl TP -LINK_5GHz DATA16
|Pvd address:
Password: [JRQEFER

O Bthemet: 192.168.1.100

@ WiF: 192 ] Encryption: (G



3.2 Creazione di un evento stazione di condivisione RightBooth

Ora nella finestra principale di RightBooth , fai clic sul
pulsante " Crea" e nel pannello successivo scegli " Crea un
evento stazione di condivisione ", quindi fai clic sul pulsante m ™ O Create a sharing station event
" Avanti ":

Nota: questa opzione & disponibile in RightBooth versione 7.7.0 o successiva.

Fatti strada attraverso I'Event Wizard per creare il tuo evento Sharing Station. Quando é stato creato, puoi
utilizzare RightBooth Screen Editor per modificare il tuo evento in base alle tue esigenze di progettazione.

Salva il tuo evento Sharing Station e assegnagli un nome file univoco. Per lo scopo di questo tutorial
supponiamo che tu stia creando una Sharing Station per un evento di Halloween, quindi per il nostro
esempio salveremo il file dell'evento Sharing Station come Halloween1.

Punti importanti da notare

1) Un evento RightBooth Sharing Station € progettato per guardare (monitorare) una sottocartella nella
cartella del server Web locale (c:\wamp64\ www OPPURE c:\xampp\htdocs) per I'arrivo di video e
foto. RightBooth creera automaticamente questa sottocartella quando si salva il file dell'evento della
stazione di condivisione. La sottocartella avra lo stesso nome del file dell'evento della stazione di
condivisione. Quindi continuando con I'esempio, RightBooth creera automaticamente Ia
sottocartella:

c:\wamp64\www\halloween1 (se stai usando WampServer ) OPPURE
c:\xampp\htdocs\halloween1 (se stai usando Xampp )

2) Sinoti che RightBooth non consente di includere spazi quando si assegna un nome al file dell'evento
della stazione di condivisione. Cio significa che il percorso della cartella di controllo non include spazi
nel percorso completo.

3) La cartella Watch dell'evento della stazione di condivisione & impostata nel designer di eventi di
RightBooth nella scheda Tipo di evento . Per impostazione predefinita, RightBooth utilizza due
variabili di testo per definire la cartella Watch come segue:

a. {WEBSERVERROOT} — Rappresenta la cartella del server Web locale e viene prelevata
automaticamente da Impostazioni RightBooth -> Social media -> Server Web locale (vedere
la sezione 3.1 sopra).

b. {EVENTFILENAME} — Questa variabile di testo rappresenta il nome file del file evento della
stazione di condivisione, che nel nostro esempio & halloweenl .

In questo screenshot puoi vedere che abbiamo salvato I'evento come halloweenl . Si noti che la
definizione completa della cartella di controllo &: {WEBSERVERROOT }{ EVENTFILENAME}\ Cio significa
che nel nostro esempio, la cartella di controllo effettiva monitorata &: c:\wamp64\www\halloween1\
(o c:\xampp\htdocs\halloween1 \ for Xampp ) Non dovrebbe essere necessario modificare le
informazioni in questa casella di testo. E a causa di queste variabili di testo, se si salva I'evento della



stazione di condivisione con un nuovo nome file, RightBooth guardera automaticamente una
sottocartella diversa nella cartella del server Web locale.

(&) Event Designer: halloween1 - O X

Eventtype Eventstructure Eventtext Event questions  Event social media Event flow Event files/folders Event camera _

Choose the event type:

@ Recording ® Menu @ Information @ Watch folder O Sharing staticn
Lm Interruptable

changes

Recording types included in this event: Videos, photos and print la

Watch folder

{WEBSERVERROOTHEVENTFILENAMER =

4) Se guardi in RightBooth Screen Editor, vedrai la schermata dell'evento ' Media browser' nell'elenco
Screen. Cio includera un elemento di visualizzazione multimediale che viene impostato
automaticamente per visualizzare tutti i video e le foto che appaiono nella cartella Guarda
(menzionata sopra) durante la riproduzione dell'evento.

5) Anche nell'editor di schermate ci sono le schermate dell'evento " Mostra video" e " Mostra foto"
che visualizzeranno ciascuna due elementi del codice QR:

e |l primo codice QR e un codice " Connetti al WiFi " e viene creato automaticamente dalla
procedura guidata evento utilizzando i valori del " codice QR della rete WiFi " descritti nella
sezione 3.1 (sopra). La scansione di questo codice consentira ai tuoi ospiti di accedere alla
tua rete Wi-Fi privata senza dover inserire manualmente la password Wi-Fi .

e Anche il secondo codice QR viene creato automaticamente dalla procedura guidata
dell'evento. Durante la riproduzione dell'evento, questo codice QR verra aggiornato per
contenere il percorso e il nome file del video o della foto che & stato scelto nella schermata
del browser multimediale. Durante la riproduzione dell'evento, la scansione di questo codice
consentira ai tuoi ospiti di scaricare il video o la foto scelti sul proprio dispositivo mobile
dalla cartella di controllo nel tuo server web locale.

Se esamini il contenuto del secondo codice QR nello Screen Editor vedrai che contiene due variabili di
testo:

o {IPSERVER WEB} — quando l'evento € in riproduzione, questo viene automaticamente
sostituito dall'indirizzo IPv4 del tuo computer (preso da Impostazioni RightBooth , in
precedenza).

e {EVENTFILENAME} — Quando l'evento & in riproduzione, viene automaticamente sostituito dal
percorso e dal nome del file del video o della foto scelti nella schermata dell'evento del
browser multimediale.



ey

%) QR code

Enter text for the QR code:

http://{WEBSERVERIP}/{EVENTFILENAME}/

Lo screenshot di esempio sopra & tratto dalla schermata dell'evento "Mostra video". Nell'editor dello
schermo di RightBooth , se fai doppio clic sul codice QR, vedrai la sua definizione (come mostrato nella
schermata). Il testo del codice QR viene aggiunto automaticamente dalla procedura guidata dell'evento
RightBooth ed é:

http://{WEBSERVERIP}/{EVENTFILENAME}/

Rappresenta il percorso completo della cartella di controllo della stazione di condivisione ed & formattato
come collegamento URL.

IMPORTANTE: non dovrebbe essere necessario modificare questo testo, quindi dovrebbe essere lasciato
esattamente come mostrato, incluso |I' http:// iniziale e il finale /

Si noti inoltre che il tipo di codice QR nello screenshot sopra & Text + Video . Cid significa che durante la
riproduzione dell'evento, al testo del codice QR verra aggiunto anche un file html che definisce una pagina
Web di download per il file video. Questo file html wrapper viene creato automaticamente da RightBooth
quando la pagina "Mostra video" viene mostrata all'ospite. Il file video e il file HTML vengono entrambi
copiati in una sottocartella \ rbgr e questa & la cartella in cui viene diretta la scansione del codice QR di tutti i
singoli file e la cartella da cui avviene tutta I'attivita di download dei file nella stazione di condivisione.

Quindi, continuando con il nostro esempio, supponiamo che il tuo ospite abbia selezionato il file video:
2021-6-27-22-46-59-video.mp4 nella schermata del browser multimediale, quando il tuo ospite esegue la
scansione del codice QR sul video "Mostra" schermo il loro telefono verra indirizzato alla seguente pagina
web sul tuo server web locale, utilizzando I'indirizzo IPv4 del tuo computer (definito in precedenza):

http://192.168.1.100/halloween1/rbqr/2021-6-27-22-46-59-video.mp4.html



Nota: il file html della pagina Web di download puo essere personalizzato in RightBooth -> Impostazioni
- Social media > Server web locale. Nel nostro esempio puoi vedere che stiamo includendo la nostra
immagine banner:

Web gallery + Webpage for file download

EL R RightBooth Sharing Station Test
Your banner CihUsersinrpsutPicturestrylandscape.png =

Gallery prompt

O Ascending date

Image display size — m— —— ()

B Include Contact button
Tel no Button text

I Videos Photos

@ Descending date

Use your own HTML templates

OK. Il tuo evento RightBooth Sharing Station & ora pronto per essere giocato. Durante la riproduzione,
I'evento della stazione di condivisione monitorera la sua cartella di controllo per I'arrivo di video e foto.
Questi video e foto proverranno dal tuo evento di registrazione RightBooth ed € qui che entra in gioco la
prossima attivita.



Attivita 4 - Creazione di un evento di registrazione RightBooth per inviare

video e foto al server Web locale

Useremo ora RightBooth per creare un evento di registrazione video (o foto).

e Assicurati che RightBooth sia in esecuzione.

e Assicurati di aver salvato il file dell'evento della stazione di condivisione.

e Ora, nel pannello principale di RightBooth , fai clic sul pulsante " Crea" e utilizza la procedura guidata

evento per creare un evento di registrazione video e/o foto .

e Ancora una volta, procedi attraverso la procedura guidata dell'evento per creare il file dell'evento di

registrazione video. Quando ¢ stato creato, puoi utilizzare RightBooth Screen Editor per modificare il

tuo evento in base alle tue esigenze di progettazione.

e Vaiall'Event Designer -> Scheda File/cartelle evento .

e Nella sezione etichettata: Scegli quando eseguire le azioni di copia dei file: ora devi decidere

guando RightBooth copiera i video e le foto nella cartella del server Web locale della stazione di

condivisione.

o Perla copia video puoi scegliere una delle seguenti opzioni:

Dopo la creazione : se scegli questa opzione, RightBooth copiera i video
immediatamente dopo che sono stati registrati ed elaborati.

Schermata "Mostra" - Se scegli questa opzione, RightBooth copiera i video quando
viene visualizzata la schermata dell'evento "Mostra video" . IMPORTANTE: se scegli

guesta opzione ma il tuo evento non include la schermata dell'evento " Mostra
video" , la copia del file video non avverra.

Schermata "Opzioni" : se scegli questa opzione, RightBooth copiera i video quando
viene visualizzata la schermata dell'evento "Opzioni video" . IMPORTANTE: se scegli
guesta opzione ma il tuo evento non include la schermata "Opzioni video" , la copia
del file video non avverra.

"Dopo il completamento"” : se scegli questa opzione, RightBooth copiera i video
quando l'utente corrente ha terminato il tuo evento quando viene visualizzata la

schermata dell'evento di ringraziamento .

o Per la copia delle foto puoi scegliere una delle seguenti opzioni:

Dopo la creazione : se scegli questa opzione, RightBooth copiera le foto subito dopo
che sono state scattate ed elaborate.

Schermata "Mostra" - Se scegli questa opzione, RightBooth copiera le foto quando
viene visualizzata la schermata dell'evento "Mostra foto" . IMPORTANTE: se scegli
guesta opzione ma il tuo evento non include la schermata dell'evento " Mostra
foto", la copia del file della foto non avverra.

Schermata "Opzioni" : se scegli questa opzione, RightBooth copiera le foto quando
viene visualizzata la schermata dell'evento "Opzioni foto" . IMPORTANTE: Se scegli
qguesta opzione ma il tuo evento non include la schermata 'Opzioni foto', la copia
dei file delle foto non avverra.

'‘Dopo il completamento’ : se scegli questa opzione, RightBooth copiera le foto
quando l'utente corrente ha terminato il tuo evento, quando viene visualizzata la
schermata dell'evento di ringraziamento .



e Ora seleziona l'opzione: ' Sostituisci le azioni di copia del file... '

e Fai clic sul pulsante " Aggiungi" , quindi cerca la cartella di controllo per la tua stazione di
condivisione, che nel nostro esempio & c:\wamp64\www\halloween1) e scegli "Seleziona cartella" .
Il percorso della cartella Halloween1l verra quindi aggiunto alla tabella Copia file (come mostrato
nello screenshot seguente).

e Nella tabella, seleziona le caselle Foto e Video . Continuando con il nostro esempio, stiamo
scegliendo di copiare i video quando RightBooth visualizza la schermata "Mostra" del video e anche

di copiare le foto quando RightBooth visualizza la schermata "Mostra schermata" della foto :

Event type Event structure  Event text  Event questions  Event social media  Event flow  Event files/folders _

hen to perdform file Videos Photos+ Thumbnails

chions
- oo e ~

Prints

tace the File Copy actions ( in RightBooth Folder settings ) with event specific File Copy actions

Copy files to other drives and folders

User details » Photo
Emails number(s)

Folder Photos  Thumbs Prints Videos Messages

%] O

Nota: se stai usando Xampp invece di WampServer, la cartella Copy sara:

C:\xampp\htdocs\halloween1\

Riepilogo: in questo esempio, sto istruendo |' evento di registrazione di RightBooth a copiare i video
registrati e le foto acquisite nella cartella halloweenl ogni volta che vengono mostrati nelle schermate
"Mostra video" e "Mostra foto" di RightBooth . Cio significa che durante la riproduzione dell'evento, ogni
volta che un video viene registrato e mostrato all'utente, verra contemporaneamente copiato nella cartella
di controllo di Sharing Station. Lo stesso vale per le foto.

Ora salva questo file di eventi. Nel nostro esempio salveremo il file come: Halloween1Rec



Attivita 5: configurare un desktop esteso di Windows

Successivamente, & necessario configurare il computer con un desktop esteso e 2 monitor . Dovresti
assicurarti che almeno uno dei tuoi monitor sia un touchscreen , idealmente dovrebbero esserlo entrambi.

5.1 Collegare un secondo monitor

Se utilizzi un laptop o una tavoletta grafica, puoi collegare il secondo monitor alla porta VGA (o HDMI)
esterna sul lato del laptop/tablet.

Se utilizzi un PC desktop, avrai bisogno di una scheda grafica con 2 porte VGA (o HDMI) esterne a cui
collegare entrambi i monitor.

Collega il tuo secondo monitor e accendilo. Windows dovrebbe quindi riconoscere il secondo monitor e
duplicare automaticamente i display in modo che entrambi mostrino la stessa immagine del desktop.

5.2 Estendere il desktop

Ora devi configurare le impostazioni di visualizzazione di Windows come desktop esteso.

Fai clic con il pulsante destro del mouse sul desktop e scegli "Impostazioni di visualizzazione" dal menu a
comparsa...

View >
Sort by >
Refresh

Paste

Paste shortcut

Undo Rename Ctrl+Z
> Open with Visual Studic

Git GUI Here

Git Bash Here

£ Intel® Graphics Settings
E] nvIDIA Control Panel

Mew >

1 Display settings
bl Fersonalise

Nelle impostazioni dello schermo di Windows, nella sezione: "Piu schermi", scegli I'opzione: "Estendi questi
schermi":

Multiple displays

Multiple displays

Extend these displays '




Il desktop di Windows ora si estendera sul secondo monitor.
5.3 Riorganizzare i display
In Impostazioni schermo, disponi i tuoi schermiin modo che il monitor 2 si trovi a destra del monitor 1:

Rearrange your displays

Select a display below to change the settings for it. Press and hold (or select) a display, then drag
to rearrange it.

| /

Nota: questo non e strettamente necessario ma € la disposizione piu logica.

IMPORTANTE: se il secondo monitor &€ un monitor touchscreen , & ora necessario configurare il touchscreen
in modo che i relativi input tattili siano mappati alle coordinate del monitor del desktop esteso e non al
monitor principale. Il modo in cui cio viene fatto puo variare a seconda della marca/modello. Quindi i
dettagli su come eseguire questa operazione saranno disponibili nel manuale del touchscreen o dal
produttore del monitor touchscreen .

Questo video ti mostrera come farlo per la maggior parte dei touchscreen : https://youtu.be/bZ_zD4ldvFs

Inoltre potresti voler rendere la risoluzione del display di ogni monitor uguale, ad esempio 1920 x 1080.

5.3 Nascondere la barra delle applicazioni di Windows

Fare clic con il tasto destro sulla barra delle applicazioni di Windows e selezionare " Impostazioni barra delle
applicazioni” . In Impostazioni barra delle applicazioni, nella sezione: "Display multipli", imposta "Mostra
barra delle applicazioni su tutti i display" su " Off ":

Multiple displays

Show taskbar on all displays

@ or




Attivita 6: esegui 2 istanze di RightBooth per riprodurre
contemporaneamente I'evento Sharing Station e I'evento Recording

Quindi, per ricapitolare, hai creato due eventi RightBooth e li hai salvati. Nel nostro esempio abbiamo
creato:

o Halloweenl — Questo evento & un evento Sharing Station.
o Halloween1Rec - Questo evento & un evento di registrazione video e acquisizione di foto.

Ora vogliamo farli suonare entrambi contemporaneamente, ciascuno su un monitor diverso.

6.1 Istanza RightBooth 1

Innanzitutto, devi decidere quale evento verra riprodotto su ciascun monitor. Nel nostro esempio,
riprodurremo I'evento Sharing Station sul monitor 2 e I'evento di registrazione sul monitor 1.

MOLTO IMPORTANTE: eseguiremo 2 istanze di RightBooth , cio significa che RightBooth verra eseguito due
volte sul computer. E ricorda, ogni istanza di RightBooth ha le proprie impostazioni indipendenti

e Assicurati che RightBooth NON sia in esecuzione, quindi...

e Eseguire la prima istanza di RightBooth . Questa istanza di RightBooth utilizza tutte le impostazioni
immesse nell'attivita 3 per la stazione di condivisione, pertanto contiene tutte le impostazioni del
server Web locale. Pertanto, dobbiamo utilizzare la prima istanza di RightBooth per riprodurre
I'evento Sharing Station.

e April'evento della stazione di condivisione.

e Andare su RightBooth Settings -> User input e scegliere il metodo di input dell'utente per I'evento
della stazione di condivisione. Nel nostro esempio interagiremo con l'evento della stazione di
condivisione utilizzando un touchscreen sul secondo monitor:

(5 RightBooth Settings

!Cumcras Printers Userinput Qverlays/Props  Text/La

Select the user input device for controlling the event

® Single keyboard key

ES— -

Choice selector arrow speed

® Multiple keyboard keys
® USE button @ USB buttons

® Mouse O Touchscreen

Mouse as secondary input

Si noti che nel nostro esempio abbiamo anche scelto ' Mouse as secondary input' . E necessario impostare
guesta opzione se si prevede di utilizzare il mouse contemporaneamente al touchscreen .



e Nel nostro esempio vogliamo che le schermate degli eventi di
Sharing Station appaiano sul Monitor 2, quindi in Event Monitor 1 screens. On display:
Designer -> Event structure -> Multiple monitors , modifica
le schermate del Monitor 1 in modo che appaiano sul Display
2:

e QOra salva l'evento.

6.2 RightBooth Istanza 2
MOLTO IMPORTANTE: ora DEVI mantenere in esecuzione la prima istanza di RightBooth .

e Fare doppio clic sull'icona RightBooth Desktop per avviare I'esecuzione di una seconda istanza di
RightBooth . Ti verra chiesto se desideri eseguire un'altra istanza di RightBooth . Scegli "Si". Quando
esegui la seconda istanza di RightBooth, mostrera un "2" nell'angolo in alto a destra per farti sapere
che & la seconda istanza:

Ricorda, questa seconda istanza di RightBooth ha le proprie impostazioni indipendenti, quindi la prima volta
che esegui l'istanza dei secondi verrai portato attraverso l'installazione guidata. Inoltre, avrai bisogno di un
secondo codice prodotto per la seconda istanza di RightBooth . Senza un secondo codice prodotto, la
seconda istanza di RightBooth verra eseguita solo in modalita di valutazione.

Ora, usando la seconda istanza di RightBooth :

e April'evento di registrazione
e Andare su Impostazioni RightBooth -> Input utente e scegliere il metodo di input utente per
I'evento di registrazione. Nel nostro esempio interagiremo con I'evento di registrazione utilizzando il

mouse:



1 (&) RightBooth Settings

| Cameras Printers  Userinput  Overlays/Props  Text/Lai

Select the user input device for controlling the event

@ Single keyboard key

ER— -

Choice selector arrow speed

@ Multiple keyboard keys

@ USE button @ USE buttons

O Mouse @ Touchscreen

o Nel nostro esempio vogliamo che le schermate dell'evento di registrazione appaiano sul Monitor 1,
quindi in Event Designer -> Event structure -> Multiple monitors , conferma che le schermate del
Monitor 1 sono impostate per apparire sul Display 1. Questa & l'impostazione predefinita, quindi non
dovrebbe essere necessario modificare nulla:

Monitor 1 screens. On display:

e QOra salva l'evento.

6.3 Gioca entrambi gli eventi

OK. Ora hai 2 istanze di RightBooth in esecuzione. La prima istanza ha caricato I'evento Sharing Station e la
seconda istanza ha caricato I'evento di registrazione, qualcosa del genere:
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Ora, fai clic sul pulsante "Riproduci" in entrambe le istanze di RightBooth per riprodurre entrambi gli eventi
contemporaneamente, ciascuno su un monitor diverso.

Sul monitor 1 e ora possibile utilizzare I'evento di registrazione per registrare video e scattare foto e questi
verranno automaticamente copiati nella cartella di controllo della stazione di condivisione.

Contemporaneamente sul monitor 2 puoi anche utilizzare I'evento della stazione di condivisione per
sfogliare i video e le foto e scaricarli con la scansione del codice QR sul tuo dispositivo mobile, tramite il tuo
server web locale e la rete WiFi privata del tuo router .

Lavoro fatto! E... ben fatto!

Le cose non funzionano? Lista di controllo
Prova quanto segue:

- Spegni tutto.

- ldealmente assicurati che il computer sia connesso al router tramite cavo Ethernet.

- Accendi il router e lascialo inizializzare. Questo potrebbe richiedere fino a 1 minuto.

- Accendi il computer.

- Verifica che Windows sia connesso alla rete del router tramite connessione Ethernet, non tramite
WiFi . Puoi verificarlo nell'elenco Rete a cui si accede dalla barra delle applicazioni di Windows.
Assicurati inoltre che nessun'altra rete Wi-Fi sia impostata (selezionata) su "Connetti
automaticamente".

- Assicurati che WampServer (o Xampp ) sia in esecuzione e che la sua icona sia diventata verde.

- Eseguire ipconfig (in un prompt di Windows Cmd ) e prendere nota dell'indirizzo IPv4 che & stato
fornito al computer dal router.

- Prendi un telefono cellulare e connettiti manualmente alla rete WiFi del router .



Apri il browser sul tuo telefono e digita l'indirizzo IPv4 annotato in precedenza nella casella
dell'indirizzo del browser e premi Invio. Verificare di poter vedere il server Web locale sul computer.
In caso contrario, sul computer, controlla che Windows Firewall e Windows Defender siano entrambi
disattivati.

Verifica che la porta 80 non sia bloccata sul tuo computer.

Assicurati che sul computer NON sia in esecuzione un'app antivirus.

Awvia la prima istanza di RightBooth e apri I'evento Sharing Station. Nota: in questo tutorial la
Sharing Station dovrebbe essere sempre aperta nella prima istanza di RightBooth .

Nella prima istanza di RightBooth , verifica che la cartella Watch definita in Event Design -> Event
type sia quella descritta in questo documento.

Nella prima istanza di Impostazioni RightBooth -> Social media -> Server web locale , controlla che
I'indirizzo IPv4 del server sia impostato correttamente su quello annotato in precedenza.

Nella prima istanza di Impostazioni RightBooth -> Social media -> Server web locale , controlla che
le impostazioni WiFi del router siano state inserite correttamente.

Avvia la seconda istanza di RightBooth e apri I'evento di registrazione.

Nella seconda istanza di RightBooth Event Design -> Event files and folders , assicurati di copiare
video e/o foto nella cartella di controllo dell'evento di Sharing Station. Verifica di aver scelto le azioni
di copia file corrette per il tuo evento. Rivisita l'attivita 4 per i dettagli su come eseguire questa
operazione.

Riproduci I'evento della stazione di condivisione nell'istanza 1 di RightBooth e controlla che mostri i
video e le foto dalla cartella Guarda.

Riproduci I'evento di registrazione nell'istanza 2 di RightBooth e controlla che i file di video e/o foto
vengano copiati nella cartella di controllo dell'evento di Sharing Station e controlla anche che il
browser multimediale dell'evento di Sharing Station si aggiorni correttamente per mostrare nuovi
video e foto se sono registrati .



